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1. Introduction to Kernel for PST to NSF

Welcome to the user manual for Kernel for PST to NSF, the most powerful, professional and easy to use
conversion software that helps you to convert emails and other items of PST file to NSF file which can be
easily accessed with Lotus Notes. This user manual comprises step by step guidelines on using Kernel for
PST to NSF.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for PST to NSF. We suggest that first time
users should read this user manual completely and carefully before proceeding to use the software.
However, if you are an experienced user, you can use the table of contents to find out information
pertaining to the tasks that you need to perform by using Kernel for PST to NSF.
You can use the table of contents to navigate through different sections of this user manual. The table of
contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

e Introduction

e Getting Started

e Software Interface

e Converting PST files to NSF files

o Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

MS: Microsoft
PST: Personal Storage File
NSF: Notes System File
RAM: Random Access Memory
MB: Mega-Byte
Kernel ¥
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GB: Giga-Byte
1.2 About Kernel for PST to NSF

Kernel for PST to NSF is an email migration tool for MS Outlook email client. Kernel for PST to NSF is
result oriented software to convert emails and other items of .pst file to .nsf file. Kernel software
successfully converts emails, calendar, drafts, journals and other items of pst file to nsf file to be easily
accessed with Lotus Notes e-mail client.

Kernel for PST to NSF converts items of pst file and saves the converted items in the new or existing nsf
file. Provide .pst file to the software, which will then convert and recreate same folder structure in a new or
existing nsf file.

Quickly and securely convert user's emails, sent items, journals, drafts, appointments and contacts with
Kernel for PST to NSF. For conversion, it supports every Lotus Notes version 8.0, 7.0 and 6.5 and MS
Outlook 97 and above versions

1.3 Salient Features

Salient features of Kernel for PST to NSF include:

o It efficiently converts emails and other items of pst file to nsf file which can be easily accessed with
Lotus Notes email client.

e Saves converted file in New or Existing NSF file
e Supports Unicode character conversion.

e Converts each and every item including emails, attachments, contacts, calendars, appointments,
journals, to-do item list, sent mails, drafts, alarms, rules, created personal folders and many more.

e Saves converted item in Plain Text / With Formatting

o Kernel for PST to NSF supports every version of Lotus Notes and MS Outlook to perform the
process of email migration.

o Free demo to test the capabilities of the tool before purchasing it.

1.4 Who Should Use this Software?

The capability of Kernel for PST to NSF to convert emails and other items of PST file to NSF file make it
the best available tool for email migration. Kernel for PST to NSF efficiently converts emails and other
items of a PST file to NSF file and provides professionals, organizations and individual users with a secure
email migration process.
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2. Getting Started

Now that you have understood the features and potential of Kernel for PST to NSF, you are ready to get
hands on experience of the software. To start converting PST files to NSF files, first of all you will need to
download and install this software.

It is strongly recommended that before installing Kernel for PST to NSF, you should go through the
installation pre-requisites for the software to ensure that your computer is appropriately configured to run
the software.

2.1 Installation Pre-requisites

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation
o Disk Space - Enough space to save the results

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into three categories —
Operating system requirements and Lotus Notes and MS Outlook version requirements. The software
requirements are as follows:

2.1.2.1 Operating System Requirements
Supported Operating Systems:

e Windows Vista

e Windows XP

e Windows 2003

e Windows 2000
2.1.2.2 MS Outlook Version Requirements
Supported MS Outlook versions:

e MS Outlook 97, MS Outlook 98, MS Outlook 2000, MS Outlook 2002, and MS Outlook 2003

Kernel _p;j
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2.1.2.3 Lotus Notes Version Requirements

Supported Lotus Notes versions:

e Lotus Notes8, Lotus Notes7 and Lotus Notes6.5

2.2 Downloading Kernel for PST to NSF for the First Time

After checking your computer with the prescribed system requirements for Kernel for PST to NSF, you can
download and install the software on your computer. You can buy the full version of the software from any
one of our authorized resellers — Element5, Asknet and 2CO.

If you want to try using Kernel for PST to NSF before buying it, you can download the evaluation version
from the following link:

https://www.nucleustechnologies.com/download-pst-to-nsf-conversion.php

2.3 Install Kernel for PST to NSF

After downloading the installer file for Kernel for PST to NSF, you can install the software by running the
file.

To install Kernel for PST to NSF:

1. Double-click the Kernel for PST to NSF installer. Follow the on-screen instructions. The Setup
Installation Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for PST to NSF

To start Kernel for PST to NSF:
Click the Start > All Programs >Kernel for PST to NSF

Alternatively, you can launch Kernel for PST to NSF by double-clicking the shortcut icon available on the
Desktop and Quick Launch icon.

2.5 Uninstall Kernel for PST to NSF

You may need to uninstall Kernel for PST to NSF. To uninstall Kernel for PST to NSF:
1. Click Start = All Programs >Kernel for PST to NSF - Uninstall Kernel for PST to NSF
A warning message will be displayed.

2. Click Yes to uninstall Kernel for PST to NSF.

X Before proceeding to uninstall Kernel for PST to NSF, you must ensure that the
software is not running on your computer.
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You can alternatively uninstall Kernel for PST to NSF from the Control Panel by performing the following
steps:

1. Click the Start Menu = Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for PST to NSF and click Remove. A warning message will be displayed.

3. Click Yes to uninstall Kernel for PST to NSF.

3. Software Interface

Now that Kernel for PST to NSF has been installed on your computer, you can start using the software
after getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for PST to NSF comprises two main menus — File and Help.

3.1.1 File Menu

The File menu comprises three menu items.

File | Help

|} Select PST File

b Export

Exit

Figure 3.1: File Menu

Menu items in the File menu:
Select PST File Opens the Open Window
Export Opens Save Options Window

Exit Close the software

3.1.2 Help Menu

The Help menu comprises three menu items.
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| Help |
= Help

.1 Software horme page..
Abouk Kernel For PST ko NSF

Figure 3.2: Help Menu

Menu Items in the Help menu:

Help Displays help information pertaining to performing various
tasks using Kernel for PST to NSF

Software Homepage Visit software homepage of website
About Kernel for PST to Displays version-related and support information of
NSF Kernel for PST to NSF

3.2 Tool-bar

The tool-bar in Kernel for PST to NSF is displayed below the menu-bar. The tool-bar provides a
convenient and user-friendly method to perform certain actions that can also be performed by using the
menu-bar.

Read the information in the table below to find out about the tool-bar buttons:

Select PST File Opens the Open Window
v
Select PST File
lfd Export Opens the Save Options Window
Export
?) Help Displays the user manual of Kernel for PST to
il NSF
Help
:g Buy Online Purchase the software online from website
Buy Cnling
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3.3 Status Bar

Status bar is displayed at the bottom of the software window. The text ‘www.nucleustechnologies.com’ is
displayed on the status bar when you open the software. The Status bar also displays the text ‘CAP’,
‘NUM’, ‘SCRL’ which respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your
keyboard. If any of these keys are pressed, the color of the corresponding text will turn blue/black.

3.4 Customize User Interface

You can add or remove toolbar buttons by clicking:

- - Add or Remove Buttons - Standard in the toolbar and selecting appropriate buttons.

Kernel 5%
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4. Converting PST files to NSF files

4.1 Converting PST files to NSF files

Now that you have complete familiarity of the user interface of Kernel for PST to NSF, you are ready to
convert PST files to NSF files. For converting PST files to NSF files, follow these simple steps:

e Launch Kernel for PST to NSF

K] Kernel for, PST to NSF ver B.07.01

© Fle  Help

e B @

Seleck PST File  Expork Help

i YU I
e =) s

Euy Orline DATA RECOVERY

& Stepl
Please select the PAT file
ko expoart

Step 2

Select the Save option ko
save PST File ikems ko new
or an existing MSF file

Step 3

Select the Outloak,
Falder{s) which wou wank

bo export
Kernel

— Select PST File to export by clicking [ Select PST File ] button

‘ ‘ [ Select PST File

— Export Outlook PST ba Lotus Makes MSF Fils in simple three steps: Selact, Export and Save,
)
Export emails, contacts, deleted items, journals, calendars, appointments, nokes, alarms, scheduled

tasks, sent items, outbox, tasks, drafts, junk emails, attachments, email properties, and orphan
Folders of PST file ko MSF File,

v, niucleustechnologies, con

UM

Figure 4.3: Kernel for PST to NSF Window

o Click Select PST File to select the .pst file. Open window to select the PST file will appear.
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Open

Look jn: | < Local Disk-Test [E:) ¥ 02 2 E

by Recent
Documents

!

Dezktop

’a

N

\$

ty Docurments

ky Cormputer

.

File name: | k.emel pst A | [ Qpen ]

My Network | Files of type: \PST Filel* ps] v| | Cancel |

Figure 4.2: Open Window

e Select the .PST file from your hard drive and click Open. Selected .pst file will get listed on the screen
of the software.
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:K..[ Kernel for PST to NSE ver B.07.01

File  Help

Select PST File  Export Help  Buy Online - DATA RECOVERY

v Stepl

Please seleck the PST file
ko export

@ Step 2 — select PST File to export by clicking [ Select PST File ] button
Select the Save option ko [
save PST File items to new
of an existing M5F file | E:\Kernel.pst ‘ [

Select PST File

Step 3
Select the Outlook

Eolder(s)twhich yiou want s Expart Qutlook PST ba Lokus Maokes MSF file in simple three steps: Select, Expart and Save,
0 Expor - !]

Export emails, contacts, deleted ikems, journals, calendars, appointments, notes, alarms, scheduled
tasks, sent ikems, outbox, kasks, drafts, junk emails, attachments, email properties, and orphan
falders of PST file ta NSF File,

Kernel

v, nucleustechnologies. com T

Figure 4.3: Kernel for PST to NSF with the Selected PST File Window

e Click Export button to save the converted emails and other items. Save Options window will appear.
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x]

Save Options

Fleaze provide MSF file detailz
(%) Save in Mew file

MSF Faolder Path E:} E]

MNSF File Marne : ser 5 - Corwerted PST File to HSF

() Save in existing file

MSF File path :

[ 5ave item content in text format

[ ] 4 l [ Cancel ]

Figure 4.4: Save Options

¢ This Window contains two saving options i.e. Save in New File and Save in Existing File. Select the
suitable saving option and click OK.

4.2 Saving Converted Files

To save the converted file, these steps need to be performed:
e Asyou click Export , the Save Options window will appear:
o Kernel for PST to NSF provides two saving options: Save in New file or Save in Existing file
o Define the NSF file settings:
» Save in New file: If you want to save the converted items in any new NSF file
» NSF Folder Path: The NSF file path location where you want to save the file on your hard drive.
» NSF File Name: The name of the NSF file which you are saving

e If you want to save the converted items in any existing NSF file, then define the NSF file path location
where you want to save the file on your hard drive.

e |f you want to save the items of PST file without formatting, then check Save Item Content in Text
format

e Select Save in New file or Save in existing file and define the respective settings. Click "OK”.

¢ Close all instances of Microsoft Outlook and Lotus Notes, if running and click "OK" button to continue
with the saving process.

y = > : \-j;.‘a
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As you click OK, the software scans the listed .PST file and displays folders that the .PST file contains.

Select the folder which you want to save in the .nsf file and click OK to continue with the saving

process.

Qutlook Folders

Fleaze select Dutlook folder(s] to be Exported

3

= [v] R
Deleted ltems
=) [w] Personal Falders

= [#] Top of Personal Folders

Deleted ltems
=) [w] Personal Folders
=[] Roat - Public
IP_SUEBTREE

ok |

[ Cancel

Figure 4.5: Select Outlook Folders

Once saving process is successfully completed, a message will appear. Click OK.

Kernel for PST to NSF

Saving Complete |

Click Mest button to corvert another file or click Exit to cloze the software

3

Figure 4.6: Saving Complete Message

© KernelApps Private Limited
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4.3 Viewing Converted Files

Kernel PST to NSF saves the converted PST file in NSF file format to be easily accessed with Lotus Notes
email client. To view any file, follow these steps:

e Open the Lotus Notes email client application and click the Folders section.

o All the Converted Folder of PST file get saved in the respective Folder of the NSF file, which can
be viewed with Lotus Notes. For example- Iltems of Deleted Items folder of PST file will get saved
in the Deleted Items folder of NSF file.

¢ Click any of the folders in Folders section and view the items contained in it.

e Click the item to view the content.

@ mail - Top of Personal Folders - |BM Lotus Notes

CBX

Ble Edk Yiew Create Actions Tools Window Help

m @ & Home

@ Getling Started  ®

-0 9 % H + R & - | [ Search |
' B %) New ~ & Reply = 2 Forward -~ & - B - [l More - @ Q) - Eisnow - || Q
=1 Raply ~| I Forward ~ (55 I More ] oW
on Local .
Ei = |_, 1Sender Subject Date Size & P i
& UEELD = Jack George 1212772004 05:08 PM 6K Al B
“+£] Chat Hist
bl = Jack George Constant Contact E-Mail Marketing 12202004 04:15 AM 25K
T wiews & info Your Never Clean Again Price Calculation 12/20/2004 09:13 PM 1K
;"-'j;]rolders &= Jack George HillQuest - Never Clean Again ivvoice No, 40 123072004 09:57 AM I2H &
52 OWtlook =3 Jack George Revised Propoesal 123172004 03:36 PM 1023K
) Deleted tems = Jack George RE: RE: Revised Proposal 01042005 08:45 PM 5K
J Personal Folders = Jack George New Account liformation 01052005 08:49 AM 18K
I Top of Personal Folders (14 7 Jack George RE: 6L Insurance & Bond Applications 01:05/2005 10:41 AM 20K
= Deleted items (1766) 1 Jlack Georoe New Customer Match! 1052005 17:49 PM 30K o
1[5 Parsonal Folders | r .9
i3 Root - Publie | ‘ 1 Constant Contact E-Mail Marketing
- |PMBUBTREE 4 customersupport to 12/20/2004 04:15 AM
=] e Show Details
Fgmhm — - --.-Ll\J,J" -
=i Tools Browght to you by
) Other Wail
Follow Up~ él
= Remove Flag
~ When ~  Who ~
Keep your customers up-to-date with
your free new e-mail marketing account.
Dear Jack George:
¢ Create and send e-mail newsletters, promaotions, and updates o your
. g 74 = Online =

Figur
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5. Full Version

Although you can use Kernel for PST to NSF evaluation version for free and experience the capabilities of
the software, there are certain features that are not available in the evaluation version.

5.1 Requirement of Full Version

The free to evaluate demo version of Kernel for PST to NSF software is fully functional in its conversion
capabilities. It will convert your .PST file to .NSF file and lets you to view the items of NSF file with Lotus
Notes. But due to demo limitation evaluation version saves only first 10 emails and other items of the PST
file.

You will need to buy the full version of the software to view every converted email and other items of PST
file.

5.2 Purchasing Full Version

You can buy the full version of Kernel for PST to NSF from any one of our authorized resellers —
Element5, Asknet and 2CO.

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email
comprising the URL to download the full version of Kernel for PST to NSF and activation details of the
software.

Kernel _/;;33
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues
related to using Kernel for PST to NSF. The software comes with an embedded help manual that
can be accessed by clicking Help->Software Help in the menu-bar. You can also press the F1 key
on the keyboard of your computer to access the embedded help of Kernel for PST to NSF.

You can access the online help for Kernel for PST to NSF at
https:www.nucleustechnologies.com/Online-Helps.html

View Animated Working demo of Kernel for PST to NSF at
https://www.nucleustechnologies.com/Animated Demo PST to NSF.html

We also have live support wherein you can chat with our software experts at
https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries

Kernel 0
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/. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for PST to NSF.

7.1 Common Issues

Why does Kernel for PST to NSF have limitations in evaluation copy?

The free evaluation version of Kernel for PST to NSF is intended to enable you to experience the
capabilities of the software. You will need to buy the software to save every email and other item of the
converted PST file.

7.2 Frequently Asked Questions

How to Buy Kernel for PST to NSF?

You can buy Kernel for PST to NSF online at https://www.nucleustechnologies.com/buy-pst-to-nsf-
conversion.php

| have lost my full version for Kernel for PST to NSF. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.

Kernel 0
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8. Legal Notices

This section comprises the legal specification about Kernel for PST to NSF and the company
KernelApps Private Limited.

8.1 Copyright

KernelApps Private Limited accompanied user manual and documentation are copyright of KernelApps
Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be
reproduced in any form without the prior written permission of KernelApps Private Limited. No Patent
Liability is assumed, however, with respect to the use of the information contained herein.

© KernelApps Private Limited. All rights reserved.

8.2 Trademark

Kernel ® is a copyright work of KernelApps Private Limited.

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS are registered
trademarks of Microsoft Corporation.

All other brand and product names are trademarks or registered trademarks of their respective companies.

8.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is
subject to change without notice. KernelApps Private Limited provides no warranty with regard to this
manual or any other information contained here in and here by expressly disclaims any implied
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing
KernelApps Private Limited assumes no liability for any damages incurred directly or indirectly from any
technical or typographical errors or omissions contained here in or for discrepancies between the product
and the manual. In no event shall KernelApps Private Limited, be liable for any incidental, consequential
special, or exemplary damages, whether based on tort, contract or otherwise, arising out of or in
connection with this manual or any other information contained here in or the use there of.

8.4 License Agreement

Kernel for PST to NSF Copyright © by KernelApps Private Limited.
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by KernelApps Private Limited. The
terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Kernel for PST to NSF. For purposes of this License, if you have a valid license, you have the right to
use a single Licensed Copy of Kernel.

© KernelApps Private Limited -



Scope of License

Each Licensed Copy of Kernel for PST to NSF may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All
rights of any kind in Kernel, which are not expressly granted in this License, are entirely and exclusively
reserved to and by KernelApps Private Limited . You may not rent, lease, modify, translate, reverse
engineer, decompile, disassemble, or create derivative works based on, Kernel, nor permit anyone else to
do so. You may not make access to Kernel available to others in connection with a service bureau,
application service provider, or similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for PST to NSF, and any and all accompanying software, files, data and materials, are distributed
and provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there
is no warranty for the quality of data recovered. You acknowledge that good data processing procedure
dictates that any program, including Kernel, must be thoroughly tested with non-critical data before there
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Kernel covered by
this License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no
event does KernelApps Private Limited authorize you or anyone else to use Kernel for PST to NSF in
applications or systems where Kernel for PST to NSF failure to perform can reasonably be expected to
result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you
agree to hold KernelApps Private Limited harmless from any and all claims or losses relating to such
unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by KernelApps Private Limited herein.

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, nor
contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same
provision, or any other provision, of this License.
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